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ABSTRACT 

Flavonoids are a class of plant metabolites with C6-C3-C6 structure responsible for many 

biological functions, including coloration and defense. Citrus paradisi, grapefruit, contains a wide variety 

of flavonoids which are grouped by the extent of modification, examples of which are flavonols, 

flavones, and flavanones. A major modification is the addition of glucose by glucosyltransferases (GTs) 

to stabilize the structure and provide ease of transport. Glucosyltransferases can be highly substrate and 

regiospecific. With Cp3OGT, glucose is added at the 3-hydroxy position. This 3GT only accepts flavonols 

as its substrate; however, a Vitis vinifera (grape) 3-GT can accept both flavonols and anthocyanidins. 

Homology modeling using the crystallized structure of the V. vinifera GT predicted sites of amino acids 

that could influence substrate binding. The 382 position was of particular interest with arginine in C. 

paradisi and tryptophan in V. vinifera. This research was designed to test the hypothesis that a R382W 

mutation would result in altered substrate specificity. Site-directed mutagenesis was performed to form 

the R382W mutant Cp3OGT and the gene was transformed into yeast for protein expression. Western 

blot determined the optimal protein induction period for the cells, after which the cells were broken to 

extract the recombinant mutant protein. Purification of the R382W 3GT allowed for enzyme analysis to 

be performed by measuring the incorporation of radioactive glucose into the reaction product. Docking 

analysis was performed using AutoDock software with both the wild type and R382W mutant protein 

with the substrates that showed interesting activity. The results of this study indicate that the point 

mutation of arginine to tryptophan at position 382 broadened substrate and regiospecificity to include 

flavanones.  
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CHAPTER 1 

INTRODUCTION 

I. Flavonoids  

Flavonoids are one of the three major classes of secondary metabolites, the others being terpenoids 

and alkaloids.  Flavonoids are derived from phenylalanine which is produced via the Shikamate pathway 

(Figure 1). Phenylalanine is then modified through the phenylpropanoid pathway to produce the 

characteristic 15 carbon structure of the flavonoids. This structure is arranged in a C6-C3-C6 

configuration, with two benzene rings connected by a three carbon chain. The basic structure is further 

modified to yield the subclasses of flavonoids, consisting of chalcones, aurones, flavanones, flavones, 

isoflavones, dihydroflavonols, flavonols, leucoanthocyanidins, and anthocyanidins (Figure 2).  The 

oxidation and substitution of the heterocycle of the basic flavonoid structure serves to subdivide the 

flavonoids into classes and each class has a different function within the plant, such as UV protection, 

antifungal, antimicrobial, and anti-inflammatory properties (Harborne and Williams 2000), among many 

others.  
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Figure 1: Biosynthesis of flavonoids directly following the formation of Shikimate through the Shikimate 

pathway (Adapted from Crozier et al 2000). 

 

(flavanone) 

cyanidin 
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Figure 2: Diversity of flavonoid subclasses (Adapted from Ferreyra et al 2012). 

II. Glycosylation of Flavonoids  

Glycosylation is a common modification of flavonoids, resulting in over 6000 flavonoid compounds 

found in nature (Ferrer et al 2008). Glycosylation refers to the addition of any sugar molecule, while 

glucosylation refers to the addition of a glucose molecule. The production and accumulation of flavonoid 

di-glycosides are characteristic of citrus fruits and vegetative tissues (Owens and McIntosh 2009, and 

references therein). Glucosylation serves to stabilize the structure of the flavonoid, affect solubility 

which has implications in transportation, and regulates bioavailability (Vogt and Jones 2000). The type, 

extent, and site of glucosylation can vary widely between glucosyltransferases from different species 

and tissues within the same plant (Schwinn 1997). In Vitis vinifera alone, 200 putative flavonoid 

glucosides have been identified (Bonisch 2014).   

The enzymes responsible for glucosylation reactions are glucosyltransferases (GTs) that transfer a 

glucose molecule from a UDP-glucose molecule to a sugar acceptor. Some UGTs are highly substrate and 

regiospecific (McIntosh and Mansell 1990, Owens and McIntosh 2009) while others can accept a broad 

 

Dihydroflavonol 

Leucocyanidin 
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range of substrates (Osmani et al 2009); the variation in activity could contribute to the large amount of 

structural variation observed in GTs (Schwab 2003). All putative glucosyltransferases contain a 

conserved Plant Secondary Product Glucosytransferase (PSPG) box which is a UDP-glucose binding 

region (Owens and McIntosh 2016 and references therein). However, biochemical characterization has 

only been done to determine function of some of the putative enzymes in databases that have been 

assigned the identity of glucosyltransferase due to the presence of the PSPG box.  

 

Figure 3: The reaction catalyzed by Cp3GT (Owens and McIntosh 2009).  

III. Flavonoid effects on human and plant tissues 

 Some flavonoids appear to directly inhibit HIV activity, while others inhibit the enzymes required 

for viral replication (Harborne 2000 and references therein).  Flavonoids can act as scavengers of 

oxidizing species, particularly 3’,4’-dihydroxyflavonoids, and have been found in vitro to inhibit oxidation 

of low-density lipoprotein (Harborne 2000). In mammals, some flavonoids can act as antispasmolytic 

agents by relaxing smooth muscle (Middleton et al 2000). Isoflavones have been shown to possess 

oestrogenic activity (Harborne 2000).  Flavonoids such as gossypin (Viswanathan et al 1984), epicatechin 

(Viswanathan et al 1984), morin and rutin (Thirugnanasamambantham et al 1985) show analgesic 

activity. Flavonoids have also been shown to have anti-proliferative, anti-tumor, and pro-apoptotic 

properties (Taylor and Grotewold 2005 and references therein).  
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Flavonoids play a direct role in the protection of plants from insect and mammalian herbivory 

(Harborne and Williams 2000, Ferreyra et al 2012). They function as photoalexins and have allelopathic 

properties (Taylor and Grotewold 2005). The majority of constitutive antifungal agents in plants are 

isoflavonoids, flavans, or flavanones (Harborne and Williams 2000). Flavonoids provide antimicrobial 

protection and many protect from harmful UV-B radiation (Harborne and Williams 2000, Ferreyra et al 

2012).  

 

IV. Grapefruit model system 

The plant model for this research is Citrus paradisi, or the grapefruit. Citrus paradisi is known to 

accumulate a wide variety of flavonoids including flavonol, flavone, flavanone, dihydroflavonol, and 

chalcone glycosides (Owens and McIntosh 2011 and references therein, Daniel et al 2011 and references 

therein, Berhow 1998). The genus Citrus itself is known to accumulate flavanone glycosides (Jourdan et 

al 1985 and references therein). Grapefruit produce derivatives of several early flavonoid classes which 

are not found (flavonones and flavones) in high quantities in many other plants, as well as all the later 

flavonoid classes except anthocyanins. Varying amounts of flavonoids are found throughout all stages 

and tissues of the grapefruit (McIntosh and Mansell 1990 and references therein). Naringin is the 

primary flavonoid di-glycoside in grapefruit plants, making up approximately 40-70% of the dry weight 

of young leaves and fruit (McIntosh and Mansell 1990) and is rapidly synthesized during cell division 

(Jourdan et al 1985). Naringin accumulation is responsible for the bitter taste of grapefruit (McIntosh 

and Mansell 1990, Jourdan et al 1985).  

V. Flavonoid GT Structure and Function 

 Glucosyltransferases are categorized based on a variety of properties including evolutionary 

relationships, sugar donors, and substrate preference. One current classification system is the CAZy 
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database which currently separates putative GTs from a variety of organisms into 97 families (Lombard 

et el 2014) and each family has at least one biochemically characterized member. However, the 

sequence data in the database are not sufficient to determine the function of noncharacterized GTs. The 

sequence homology between GTs is very low, even between those that share substrate, regio- and/or 

stereospecificity (McIntosh and Owens 2016 and references therein). As such, biochemical analysis is 

still the most accurate method to determine function. 

 The tertiary structure of glucosyltransferases generally follows a β-α-β Rossmann-like domain 

pattern and fall into two major categories, GT-A and GT-B (McIntosh and Owens 2016 and references 

therein). Cp3GT is a GT-B enzyme, wherein the two Rossmann-like domains face each other and are 

connected by a linker region. The N-terminus of the enzyme is correlated to substrate specificity and the 

C-terminus, which is more conserved, is associated with sugar binding (Wang 2009 and references 

therein). The active site of the enzyme is located between the two domains (McIntosh and Owens 

2016).  

VI. Current study 

 Through this research, a potential change in substrate specificity of Cp3GT was analyzed using a 

site-directed mutation.  This enzyme facilitates the transfer of a glucose molecule from UDP-glucose to 

the 3-OH position of some of the flavonol class of flavonoids. The mutation chosen is the change of 

arginine to tryptophan at the 382nd positon, hereafter referred to as R382W. Arginine is a charged 

molecule, while tryptophan is bulky and aromatic. This mutation was chosen through sequence 

alignment and homology modeling with the flavonoid 3-GT found in V. vinifera.  The 3-O-

glucosyltransferase in V. vinifera can accept both anthocyanidins and flavonols as substrates; however, 

the 3-O-GT in C. paradisi will only accept flavonols as substrate (McIntosh and Owens 2016). Thus Cp3GT 

is considered highly substrate specific. This is hypothesized to be a result of the shape and orientation of 
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the binding pocket. The hypothesis of this research is that site-directed mutagenesis of R382W may alter 

the substrate and/or regiospecificity of 3-O-glucosyltransferase in C. paradisi.         
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CHAPTER 2 

MATERIALS AND METHODS 

Materials 

All reagents used for this study were analytical grade. Quercetin, kaempferol, fisetin, gossypetin, 

naringenin, hesperitin, eriodictyol, isosakuranetin, apigenin, luteolin, diosmetin, scutallarein, 

dihydroquercetin, 4’-acetoxy-7-hydroxy-6-methoxyisoflavone, and cyanidin were purchased from 

Indofine Chemical Inc. (Hillsborough, NJ). Uridine-5’-diphospho-[U-14C]- glucose (UDP-G; 50 µCi/2.5 mL) 

was purchased from Perkin Elmer. UDP was obtained from Sigma (St. Louis, MO). The pPICZA vector and 

X-33 strain of Pichia pastoris were from Sonje Roje of Washington State University (Pullman, WA) and 

one shot Top 10 competent E. coli cells were purchased from Invitrogen (Carlsbad, CA).  

ZeocinTM was purchased from Research Products International Corps (Illinois). Luria-Bertani 

broth powder, agar powder, Tris-base, β-mercaptoethanol (BME), tetramethylethylenediamine (TEMED, 

electrophoresis grade), ammonium persulfate (APS), Coomassie brilliant blue, nitroblue tetrazolium 

chloride (NBT), nitrocellulose membrane (0.4 µm pore size), ethyleneglycol monomethylether, 

Whatman chromatography paper, 3,5-bromo-4-chloro-3’-indolyphosphate p-toluidine salt (BCIP), 

sodium phosphate (NH2PO4H20), phenol, chloroform, isoamyl alcohol, 100% ethanol, acrylamide 40% 

solution (acrylamide:bisacrylamide, 19:1), peptone powder, glacial acetic acid, yeast extract, and yeast 

nitrogen base powder were purchased from Fisher Scientific (Pittsburg, PA).  

Mouse anti C-myc monoclonal antibody was purchased from Sigma Aldrich (St. Louis, MO) and 

goat anti-mouse IgG alkaline phosphatase (AP) conjugate was purchased from Novagen (Madison, WI). 

Phenylmethylsulfonyl fluoride (PMSF) was purchased from MP Biomedicals (Solon, Ohio). GoTaqR DNA 

polymerase and 5X green/colorless buffer for polymerase chain reaction (PCR), deoxyribonucleotide 
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triphosphate bases (dNTP), and restriction enzymes Sac1 and Dpn1 were purchased from Promega 

(Madison, WI). TALON Metal Affinity Resin was purchased from Clonetech (Mountain View, CA). Amicon 

Centrifugal filters were purchased from Millipore (Billerica, MA). All primers were synthesized by 

Integrated DNA Technologies.  

Site-directed mutagenesis 

The mutation R382W was designed and site-directed mutagenesis performed by SK Devaiah. The 

primers were as follows:  

Forward 5’-tgccgatgatcgggtggccattctttggg-3’ 

Reverse 5’-cccaaagaatggccacccgatcatcggca-3’ 

The primers were designed using Stratagene QuikChangeR Site-Directed Mutagenesis program (Agilent 

Technologies). PCR was performed using the forward and reverse mutagenic primers purchased from 

Integrate DNA Technologies and the QuikChangeR Lightning Site-Directed Mutagenesis Kit protocol 

(Agilent Technologies). The parent DNA strands of the PCR productes were subsequently digested with 

DPN1 restriction enzyme (Agilent Technologies) and the mutant plasmid transformed into Top 10 

competent E. coli cells (Invitrogen) via heat shock. The plasmid DNA from transformed cells was 

extracted using Quantum PrepTM Plasmid Midiprep Kit (Bio-rad), linearized using Sac1 restriction enzyme 

(Promega) and transformed into competent Pichia pastoris (Mut+) cells for protein expression as 

described in Invitrogen User Manual catalog number K1740-01.  

Homology Modeling 

EasyModeller 4.0 was used to model the protein structure of both the WT and R382W proteins. 

The sequence to be modeled was copied into the text box and the spaces removed. The .pdb file for the 

Vitis vinefera protein to be modeled against (2C1Z_NCBI) was selected and the box was checked in the 
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“Serial Number” column. The “Align Templates” tab was opened and the “Align Templates” button was 

selected. Next, the “Align Query” tab was opened and “Align Query with Templates” button was 

selected.  The “Build Model” tab was opened and “Generate Model” button was selected. Nine models 

to be generated was selected and NO for heteroatoms and automatically refine loops. Once the options 

were chosen, OK was selected and Modeller began generating models. In the command prompt 

window, the GA341 and DOPE (discrete optimized protein energy) scores were evaluated. A model with 

a GA341 score lower than 0.6 is not a viable model and a lower DOPE score indicates a better model. 

The model with the lowest DOPE score was copied to the desktop for ease of location and this was the 

model tested against. Swiss PDB Viewer was opened and the generated model was loaded. All residues 

were selected (under Select>All) and an energy minimization run (under Tools>Energy Minimization). 

The nine models were saved as PDB files.  

Docking Simulations 

PyRX was opened and the Vina Wizard tab in the bottom left of the screen selected, after which 

“Start” was clicked. The generated model was loaded by clicking the “Add Macromolecule” button. The 

folder of the model was clicked and the ligands were selected here for docking. Any ligands needed that 

were not already downloaded into PyRx were downloaded from the European Protein Data Bank. The 

plus button next to the protein name was clicked to display a list of amino acids in the model. The amino 

acids which are predicted to be important in the binding site were selected and the labels displayed by 

selecting Display, then Label, then Atoms. For UDP-Glucose, positions positions 20, 21, 290, 292, 293, 

319, 345, 346, 348, 363, 365, 366, 367, 368, and 371 were displayed. For aglycones, positions 22, 87, 

124, 150, 154, 191, 203, and 207 were displayed. The selection box in the protein view window was 

positioned so that all labeled amino acids were within the box. The “Exhaustiveness” number was set to 

50 to increase accuracy and the “Run Vina” button was selected. Nothing else was running at the same 



16 
 

time as Vina uses the maximum available processing power in order to produce the model. The resulting 

file gave the nine most likely conformations for that ligand’s docking configuration as well as the binding 

affinity in kcal/mol.  

Interpreting Docking Results 

AutoDock Tools was opened and the docking results were opened. The results were displayed as 

one molecule with multiple conformations. The model used for the docking simulation was opened 

(Analyze>Macromolecule>Open Macromolecule). The Show Interactions command was selected 

(Analyze>Docking>Show Interactions) to view only the amino acids interacting with the ligand. Msms 

was turned off as well as the spheres showing close contacts. The distances were measured between 

catalytic residues (His22, Asp122, and Ser20) and their corresponding interactions on the ligand.  

Expression of Mutant Recombinant Protein in Pichia pastoris 

YPD media consisting of 1% yeast extract, 2% peptone, 2% dextrose, and 100 mg/L zeocin was 

prepared and yeast colonies of WT and R382W were inoculated to 3 mL each aliquots of the media. The 

cultures were incubated overnight at 28°C shaking. The OD at 600 nm was checked, with an optimum 

between 2 and 6. From the overnight cultures, 1 mL of each sample was inoculated into separate 100 

mL BMGY media (1 M potassium phosphate buffer at pH 6.0, 10X YNB, 500X biotin, and 10X glycerol) in 

autoclaved 500 mL Erlenmeyer flasks. These cultures were incubated overnight, then centrifuged at 

3000xg and washed once with water and once with BMMY (1 M potassium phosphate buffer at pH 6.0, 

10X YNB, 500X biotin, and 10X methanol), and the pellets were re-suspended in three separate 100 mL 

BMMY media in 500 mL Baffled flasks. The cells were harvested 24 hours after induction with methanol 

for the wild type and 18 hours after induction with methanol for the R382W mutant and split into two 

50 mL tubes per sample, then centrifuged at 3000xg at 4°C for five minutes. The supernatant was 

removed and the pellet stored at -80°C.   
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GT purification 

The pellet stored at -80°C was resuspended in 5 mL of breaking buffer (50 mM sodium 

phosphate buffer at pH 7.5, 1 mM PMSF, 1mM EDTA, 5% glycerol, 5 mM BME) and lysed using the 

French Press (Fisher Scientific) four times at 1250psi or until the sample appeared semitransparent, with 

samples collected on ice. The samples were centrifuged at 13,000xg and 4°C for 20 minutes. The 

supernatant was kept on ice. A PD-10 column and a cobalt IMAC column were equilibriated using 

equilibriation buffer (50 mM sodium phosphate buffer at pH 7.5, 300 mM NaCl, 5 mM BME) at 4°C. 

Protein extract was added to the PD-10 column and the flow through discarded. Equilibriation buffer 

was added to the column and the eluted protein solution collected. The desalted protein solution was 

added to the IMAC column and the flow through discarded. The column was washed with equilibriation 

buffer to an OD< 0.09 at 280 nm. The bound protein was eluted using elution buffer (50 mM sodium 

phosphate buffer at pH 7.5, 300 mM NaCl, 5 mM BME, 150 mM imidazole) and collected in 2 mL 

fractions. Protein concentrations were measured with the nano drop at 280 nm.  The fractions which 

showed the highest OD were concentrated using Amicon 30 MWCO filter, centrifuging at 3000xg and 

4°C for 10-12 minutes. Two mL of final assay buffer (50 mM sodium phosphate buffer at pH 7.5, 14 mM 

BME) was added to the filter and centrifuged until the volume reached 500 µL. The protein solution was 

placed into a 2 mL tube and 500 µL of final assay buffer used to wash the Amicon filter then added to 

the sample and the concentration measured using the nano drop at 280 nm. The protein solution was 

held on ice and used immediately for assay, but could be stored in buffer containing 10% glycerol at -

80°C for 24 hours if absolutely necessary.  

Enzyme Assay 

 For the screening assay, the reaction mixture was made as follows: 50 nmol of aglycones in 5 µL 

ethylene glycol monoethyl ether, 50 µL of assay buffer (50 mM sodium phosphate buffer at pH 7.5, 14 
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mM BME), 100 nmol/10 uL UDP-14C glucose (20,000 cpm) in 10 µL of 50 mM phosphate buffer (pH 7.5), 

and 2-5 µg of purified protein. Each reaction was done in duplicate and incubated five minutes at 37°C. 

The reaction was stopped by adding 15 µL of 6 M HCl and the mixture was vortexed. Next, 250 µL of 

ethyl acetate was added to each tube, vortexed, and centrifuged for 10 seconds. Approximately 150 µL 

of the upper phase was removed and added to 2 mL of scintillation liquid in a 7 mL scintillation vial for 

each sample. The incorporation was measured using a Beckman LS 6500 scintillation counter.  

SDS-PAGE Analysis 

Two 10% SDS-PAGE gels were prepared using the following recipe.  

Table 1: Recipe for 10% separating gel for SDS-Page. 

10 % Separating Gel 1 gel 2 gel 

Deionized water 2.3 mL 4.8 mL 

40% acrylamide 1.3 mL 2.5 mL 

1.5 M Tris (pH 8.8) 1.3 mL 2.5 mL 

10% SDS 0.05 mL 0.1 mL 

10% Ammonium persulfate 0.05 mL 0.1 mL 

Tetramethylethyenediamine 0.002 mL 0.004 mL 
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Table 2: Recipe for stacking gel for SDS-Page. 

Stacking gel 1 gel 2 gel 

Deionized water 0.73 mL 4.5 mL 

40% acrylamide 0.13 mL 0.78 mL 

1.5 M Tris (pH 6.8) 0.13 mL 0.75 mL 

10% SDS 0.01 mL 0.06 mL 

10% Ammonium persulfate 0.01 mL 0.06 mL 

Tetramethylethyenediamine 0.001 mL 0.006 mL 

 

The separating gel was allowed to solidify for approximately an hour. A 1:1 ratio of butanol-

water mix was overlaid to make a straight separating gel after pouring. Once solidified, the butanol-

water mix was poured off and the stacking gel was added and allowed to solidify. Samples to be loaded 

onto the gel were prepared in 1.5 mL autoclaved labelled Eppendorf tubes using 5 µL of 4X SDS-PAGE 

dye with BME and 10 µL of samples made to the same protein concentration for a total of 15 µL final 

volume. Duplicate samples were prepared, one for Western blot analysis and the other to be stained in 

Coomassie blue (0.006 g Coomassie Brilliant Blue, 10 mL acetic acid, 40 mL methanol, made up to 100 

mL with deionized water). Reaction samples were boiled for 5 minutes to denature the protein. The SDS-

PAGE apparatus was set up with the gel between two glass plates and placed in the tank. 1X Tris-glycine 

electrophoresis buffer was added to the tank and the samples were loaded, beginning with Low range 

prestained (Bio-rad) protein marker followed by a positive control and 15 µL of the sample reaction 

mixtures. Electrophoresis was performed at 100 V for 90 minutes or until the dye front reached the end 

of the gel. Subsequently, one gel was placed into Coomassie blue stain and allowed to shake on an 

ORBITRON shaker (BOEKEL), and the other was transferred to the Western blot apparatus. After 24 
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hours, the stained gel was placed into destaining solution (300 mL methanol, 100 mL acetic acid, made 

up to 1 L with deionized water).  

Western Blot Analysis 

Two porous pads (sponges) were soaked in cold 1X transfer buffer in a glass dish and a 

nitrocellulose membrane (Thermo Scientific) was cut to the size of the SDS-gels to transfer the protein 

from the gel to the nitrocellulose membrane. The electro blotting kit was set up by placing the negative 

terminal of the transfer cassette on the bench with a porous pad on top of it, followed by 

chromatography paper, the gel and nitrocellulose membrane, followed again by chromatography paper 

and a porous pad. The positive terminal of the transfer cartridge then closed the set and the transfer 

cassette was placed in cold 1X transfer buffer in the tank. An ice pack and stir bar were added to the 

tank. The SDS-gel was electroblotted for 75 minutes at 100 V.  

After electroblotting, the membrane was carefully removed and placed in blocking solution (5% 

non-fat milk powder in 1X TBS and 0.02% sodium azide) using laboratory tongs, and allowed to shake 

gently for 2 hours or overnight at room temperature. It was then rinsed with 30 mL of 1X TBS containing 

30 µL of 20% sodium azide three times for five minutes each. The membrane was incubated in a 1:2500 

dilution with 1X TBS of monoclonal anti C-myc primary antibody solution from mouse for two hours. The 

primary antibody binds to the C-myc epitope (EQKLISEEDL) in the recombinant protein which was 

designed in the expressed protein for identification and purification of the enzyme. The membrane was 

next washed with 30 mL of 1X TBS containing no sodium azide three times for five minutes each and 

transferred to a fresh tray where it was incubated in a 1:10,000 dilution with 1X TBS of secondary 

antibody solution (Goat anti-mouse immunoglobin G-alkaline phosphatase conjugate) (Novagen) for two 

hours at room temperature, gently shaking.  
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The membrane was washed 3 times with 1X TBS solution as earlier and then transferred into 30 

mL of CHES buffer solution (pH=9.5), 60 µL of BCIP, and 60 µL of NBT. The membrane was placed on the 

shaker until protein bands appeared, approximately 3-5 minutes. Once developed, the membrane was 

washed with deionized water to stop the developing reaction. Both the destained gel and the developed 

western blot were photographed for future reference (Appendix A). 
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CHAPTER 3 

RESULTS AND DISCUSSION 

 Homology modeling was done for both the wild type Cp3GT and R382W mutant proteins based 

on the crystallized structure of the Vitis vinifera 3-O-GT (Offen et al 2006) and Clitoria ternata GT 

(Hiromoto et al 2013 and 2015). Citrus paradisi Cp3GT is flavonol specific, Vitis vinifera 3-O-GT is 

flavonol and anthocyanidin specific, and Clitoria ternatea 3-O-GT is anthocyanidin specific. There is a 

56% sequence identity and an 87% homology between Cp3GT and Vv3GT. There is a 43% identity and a 

74.4% homology between Cp3GT and Ct3GT. However, the substrate specificity of the three enzymes 

differs. Homology modeling was performed using the crystallized structures of Vitis vinifera 3-O-GT and 

Clitoria ternatea 3-O-GT to create a proposed model for Cp3GT that reflects its specificity towards 

flavonols. The mutant protein was modeled from the proposed Cp3GT model. The overall shape of the 

WT and mutant proteins is similar (Figure 4); however, when overlaid (Figure 5) clear structural 

differences emerge. The single point mutation of arginine to tryptophan at position 382, located in the 

C-terminal domain, causes changes in folding of the loop regions circled (Figure 5). The models predict 

that a single point mutation at this location could be significant enough to change the native 

conformation. These changes could alter substrate specificity due to differential ability of aglycones to 

fit in the binding pocket.   
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Figure 4: Quaternary structure of Cp3GT (left) and R382W (right). 

  

 

Figure 5: Initial model of Cp3OGT overlaid with R382W mutant protein. The WT protein is shown in blue, 

the mutant in brown. Quercetin and UDP-Glucose are docked. The WT arginine at position 382 is 

marked in green and the mutant tryptophan is marked in red. 

Quercetin

UDP-Glucose
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Next, multiple sequence alignment was performed with Citrus paradisi, Vitis vinifera, and 

Clitoria ternatea 3GTs (Figure 6). The mutation chosen is located within the conserved PSPG box; all 

three enzymes contain an arginine at the 382nd position. However, homology modeling showed that a 

point mutation in that position could cause substantial changes in folding which could result in altered 

substrate and regiospecificity.   

 

Figure 6: Sequence alignment of wild type Cp3GT and mutant R382W using Bioedit software. The PSPG 

box is outlined in black. * indicate identical amino acids for all three enzymes.  

10 20 30 40 50 60
....|....|....|....|....|....|....|....|....|....|....|....|

Vv 1 MSQTTTN--PHVAVLAFPFSTHAAPLLAVVRRLAAAAPHAVFSFFSTSQSNASIFHDS-M 57

Cp 1 .A..QSQPR..I...N.......SSV.SIIK...VS..T.L.T....P...KAL.STGQQ 60

Ct 1 --MKNKQ---...IFP...GS.LP...NL.LK..HI..NTS...IG.HS...FL.TKR-- 53

70 80 90 100 110 120

....|....|....|....|....|....|....|....|....|....|....|....|

Vv 58 HTMQCNIKSYDISDGVPEGYVFAGRPQEDIELFTRAAPESFRQGMVMAVAETGRPVSCLV 117

Cp 61 RHLPS.V.P..V.......H..S.KR.......MN..DAN..KAVEA........LT... 120

Ct 53 -HIPN..RVFT....I...H.P.NN.I.KLD..LSTG.DNL.K.IEL.....KQS.T.II 112

130 140 150 160 170 180
....|....|....|....|....|....|....|....|....|....|....|....|

Vv 118 ADAFIWFAADMAAEMG-VAWLPFWTAGPNSLSTHVYIDEIREKIGVSGIQGREDELLNFI 176

Cp 121 T........E..R.WNN.P.V.C.P.......A.L.T.I..D...TQ-S.NQDQQ.IH.. 179

Ct 113 ....VTSSLLV.QTLN-.P.IA..PNVSC...LYFN..L..D.CSKD----AKNAT.D.L 167

190 200 210 220 230 240
....|....|....|....|....|....|....|....|....|....|....|....|

Vv 177 PGMSKVRFRDLQEGIV-FGNLNSLFSRMLHRMGQVLPKATAVFINSFEELDD-SLTNDLK 234

Cp 180 ...N.I.VA..P..V.-S.D.D.V..V...Q..RQ....A...........P-E...H.. 237

Ct 168 ..L..L.VE.VPQDMLDV.EKET....T.NSL.V...Q.K..VV.F.A...PPLFVKYMR 227

250 260 270 280 290 300

....|....|....|....|....|....|....|....|....|....|....|....|

Vv 235 SKLK-TYLNIGPFNLITPPPVVPNTT-------GCLQWLKE--RKPTSVVYISFGTVTTP 284

Cp 238 T.FNNKF.SV...K.LLASDQQ.SSATDLDDEY...A..DKQKK..A..A.V.....A.. 297

Ct 228 ...Q-SL.YVV.LPCPQLLLPEIDSN-------...S..DS--KSSR..A.VC....VS. 277

310 320 330 340 350 360
....|....|....|....|....|....|....|....|....|....|....|....|

Vv 285 PPAEVVALSEALEASRVPFIWSLRDKARVHLPEGFLEKTRGYGMVVPWAPQAEVLAHEAV 344

Cp 298 S.N.I..IA.....NK........HRSQAN..N....R..SD.I..D....VN....... 357

Ct 278 ..Q....VA....E.GF..V.A.KESLLSI..K..V.R.STR.K..S.V..SH..S.GS. 337

370 380 390 400 410 420

....|....|....|....|....|....|....|....|....|....|....|....|

Vv 345 GAFVTHCGWNSLWESVAGGVPLICRPFFGDQRLNGRMVEDVLEIGVRIEGG-VFTKSGLM 403

Cp 358 .V.......G.IL..I.A...M.G........I....M.Q.WGV..AVD..GIC..E..L 417

Ct 338 .V......A..VM...SN...M.........GIAA.VIQ.IW.V..IV..K-....N.FV 396

430 440 450 460 470
....|....|....|....|....|....|....|....|....|....|...

Vv 404 SCFDQILSQEKGKKLRENLRALRETADRAVGPKGSSTENFITLVDLVSKPKDV 456

Cp 418 .SL.L..C....I.I..KVTK.KQLCQN.I..G...MQ.LDA...MI.RSY-- 468

Ct 397 KSLNL..V..D...I.D.ALKVKQIVQD....H.QAA.D.N...EVI.SS--- 446
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Table 3: Initial screening of Cp3GT and R382W performed by Dr. Shivakumar Devaiah. Verification 

performed by KAK. Initial screening reported in % relative activity to Cp3GT with quercetin; verification 

reported in % relative activity to R382W with quercetin. 

  Initial Screening  Verification 

  Cp3GT R382W  R382W 

Flavonols 

 

Quercetin 

 

100 91  100 

Kaempferol 

 

51 54  76 

Fisetin 

 

40 42  43 

Gossypetin 

 

22 19  20 

Flavanones 

 

Naringenin 

 

3 6  8 

Hesperitin 

 

3 6  5 
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Eriodictyol 

 

2 1 2 

 

 

Isosakuranetin 

 

 

2 

 

2 

  

4 

 

Flavone 

 

Apigenin 

 

2 2  6 

Luteolin 

  

2 0  43 

Diosmetin 

 

2 2  7 

Scutallerin 

 

5 4  --- 

Dihydroflavonol 

 

Dihydroquercetin 

 

2 2  98 
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Isoflavone 

 

 

 

4’-acetoxy-7-

hydroxy-6-

methoxy-

isoflavone 

 

 

 

2 

 

 

 

2 

  

 

 

6 

Anthocyanidin 

 

Cyanidin 

 

4 4  6 

  

It has been previously established that Cp3GT is specific for the flavonols quercetin, kaempferol, 

fisetin, and gossypetin (McIntosh and Owens 2016), which was also observed in the initial activity 

screening (Table 3). The initial screening assay is highly sensitive and can therefore produce false 

positives. However, this assay will not produce false negatives. These results are reported in percent 

relative activity of WT with quercetin as Cp3GT favors this flavonol over the others. The R382W mutant 

still shows a preference for the flavonols, with almost identical activity with the flavonols as the WT. 

However, the mutant protein also shows an increase in activity with naringenin and hesperitin which are 

both flavanones. This assay was repeated to confirm verify prior screening results of R382W (Table 3) 

and was reported in percent relative activity of R382W with quercetin. The verification assay shows the 

same pattern as the initial screening. This indicates that substrate specificity may have been broadened 

in the mutant protein. However, the assay also suggests an increase in activity with luteolin, 

dihydroquercetin, 4’-acetoxy-7-hydroxy-6-methoxy-isoflavone, and cyanidin. Dihydroquercetin and 4’-

acetoxy-7-hydroxy-6-methoxy-isoflavone activities have been shown previously to be false positives. 

However, luteolin and cyanidin activity could be real and should be tested with a kinetic assay.  
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Docking analysis was used for in silico analysis to predict whether reactions could occur with the 

substrates that looked promising. Distances were measured from the three catalytic residues Histidine 

22, Aspartic acid 122, and Serine 20 to their respective positions of interaction on the aglycone 

substrates (Offen et al 2006). The nitrogen on histidine 22 serves as a Bronstead base, removing 

electrons from a OH group to encourage addition of the glucose molecule at that position (Offen et al 

2006). In the case of Cp3GT, this interaction is with the 3-OH group. Aspartic acid 122 stabilizes the 

charge on His22, interacting with the side chain nitrogen (Offen et al 2006). Serine 20 is responsible for 

stabilizing the aglycone molecule in the binding pocket by interacting with the 4-keto functional group 

(Offen et al 2006). Distances smaller than 5Å have been proposed to be favorable for reactions to occur 

(Offen et al 2006). However, preference will be given to activity screening results and docking 

simulations will be used only to confirm and visualize the results.  

The first docking simulation performed was Cp3GT and R382W with quercetin (Figure 7). The 

activity screening showed identical activity between the WT and mutant proteins (Table 3) so the 

distances of the three catalytic residues to the substrate are expected to be similar as it is hypothesized 

that these distances impact enzymatic activity. This is indeed the case for the predicted model. The 

distance between His22 and the 3-OH position is 3.443Å for the WT and 3.017Å for the mutant protein. 

Both of these distances are well under 5Å and thus favorable for the reaction to occur. The distance 

between Ser20 and the 4-keto group is 3.443Å in WT and 3.017 in the mutant protein. These distances 

are both favorable for a reaction to occur. The distances between Asp122 and the side chain nitrogen of 

His22 in both the WT and mutant proteins are also favorable, at 4.591Å for WT and 3.017Å for R382W. 

This is validated by the activity screening which shows a preference of both proteins for quercetin. 

However, the WT model chosen was not the most energetically favorable model given by the software 

and was the only predicted model with distances under 5Å. Several of the predicted models for the 
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mutant protein were favorable for a reaction; thus, crystallization is needed to confirm the real protein 

structure. This is because there is not a crystal structure for a flavonol specific GT. 

 

Figure 7: Models of A) Cp3GT and B) R382W docked with Quercetin.  

The next docking simulation done was WT and R382W proteins with kaempferol. Both proteins 

had reduced activity as compared to quercetin but still favor the reaction (Table 3). This is seen as well 

in the predicted models. The distance from His22 to the 3-OH position is 3.235Å for the WT and 4.188Å 

for the mutant protein (Figure 8). Both of these are favorable distances for the reaction. The distances of 

Ser20 to the 4-keto position in both WT and R382W are favorable for the reaction, 3.235Å and 4.362Å 

respectively, but higher than those distances for quercetin (Figure 7) which could explain the reduction 

in activity. The distances between Asp122 and the side chain nitrogen of His22 are both favorable for a 

reaction to occur at 4.591Å for WT and 2.737Å for R382W. Again, the models chosen were not the most 

energetically favorable models given by the EasyModeller software. However, these models are 

validated by the activity screening. Several of the other predicted models also show favorable distances. 

A B 
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Therefore, both proteins would have to be crystallized to be confirm the real protein structure and the 

interaction with kaempferol. 

Figure 8: Models of A) Cp3GT and B) R382W docked with Kaempferol. 

The activity screening showed activity with fisetin (Table 3). The distance between His22 and the 

3-OH group of fisetin are 5.512Å for the WT and 5.404Å for the mutant protein (Figure 9). These 

distances are both over 5Å but because globular proteins are not static a reaction may still occur if at 

some times His22 is positioned closer to the substrate. The distances between Ser20 and the 4-keto 

group are well above the favorable 5Å. However, it is possible that binding of the substrate in the 

binding pocket could change the conformation enough to bring Ser20 within range for the reaction to 

occur. This could be responsible for the reduction of activity from quercetin. The distance between 

Asp122 and the side chain nitrogen of His22 in both Cp3GT and R382W are favorable as well. Again, 

both models were not the most energetically favorable models given by the modeling software. The 

most energetically favorable models gave distances too large for a reaction to occur; the activity 

screening shows activity so models were chosen to reflect the screening. However, this activity may be a 

A B 
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false positive which could be confirmed with a kinetic assay. Crystallization with and without fisetin for 

both Cp3GT and R382W would also confirm if the conformation of the binding pocket changes after the 

substrate binds to bring Ser20 into range for a reaction to occur.  

 

 

Figure 9: Models of A) Cp3GT and B) R382W docked with Fisetin. 

 The last of the flavonols docked with Cp3GT and R382W was gossypetin. The activity screening 

showed a slight decrease in activity from fisetin (Table 3). The distance between His22 and the 3-OH 

group was 5.068Å for WT and 5.525Å for the mutant protein (Figure 10). These distances are both 

slightly above the favorable distance but because globular proteins are not static a reaction could occur 

if there are moments in which His22 is closer to the substrate. The distance between Ser20 and the 4-

keto group was 5.984Å for WT and 3.715Å for R382W. There is an interesting balance that emerges 

between His22 and Ser20 where one distance is smaller in WT and larger in R382W and vice versa. This 

is likely to be the reason for a reduction in activity with gossypetin. The distances between Asp122 and 

the side chain nitrogen of His22 are both favorable for the reaction. The chosen models were again not 

the most energetically favorable conformations given by the modeling software. This is the first of the 

A B 



32 
 

substrates to have a completely different orientation within the binding pocket between WT and 

R382W. Crystallization of the two proteins with gossypetin would confirm these configurations.   

 

Figure 10: Models of A) Cp3GT and B) R382W docked with Gossypetin. 

Naringenin was docked with Cp3GT and R382W proteins because the activity screening showed 

a sharp increase in activity in the mutant protein (Table 3). This increase is readily apparent in the 

predicted models. Naringenin is a flavanone, which does not have a 3-OH group; however, HPLC analysis 

done previously in this lab with other mutants shows that the glucose molecule is added to the 7-OH 

group. It has not yet been confirmed that this is the position on R382W that receives the glucose 

molecule; however, for these models, it was assumed that the 7-OH position is the site of addition. The 

distance between His22 and the 7-OH group in the WT protein is 7.235Å which is much further than is 

favorable for a reaction to occur. However, the distance in the mutant protein is 4.602Å which is well 

within the 5Å guideline (Figure 11). These models suggest that a reaction is possible for the mutant 

protein and a broadening in substrate specificity to include flavanones. This would also suggest a 

broadening of regiospecificity as the glucose molecule is added to the 7-OH group instead of a 3-OH 

group. The distance between Ser20 and the 4-keto group is similar in both the WT and mutant proteins, 

A B 
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indicating that His22 is the most important residue for a reaction to occur. The Ser20 distance is too far 

for a reaction to occur but it is possible that substrate binding changes the conformation to become 

favorable. However, this is not the determining factor as is seen in the WT. The WT model is the second 

most energetically favorable model; however, the R382W is the least energetically favorable model 

given by the EasyModeller software. This illustrates the limitations of the modeling software. Therefore, 

it is imperative to do experiments and not to rely solely on in silico analysis.   

  

  

Figure 11: Models of A) Cp3GT and B) R382W docked with Naringenin.  

 The next substrate to show altered activity was luteolin which is a flavone. The activity screening 

showed a decrease in activity with the mutant protein compared to the WT in the initial screening but a 

huge increase in the verification (Table 3). This can be resolved using HPLC or by doing a kinetic assay. 

Docking analysis puts the distance between His22 and the 7-OH group at 4.078Å for the WT which is 

within the distance to favor a reaction (Figure 12). However, Cp3GT is not able to do a reaction using 

luteolin. Therefore, this model is likely wrong but still shows that a reaction could theoretically happen. 

The same distance for the mutant protein is 7.940Å which is too far away for a reaction to be possible. 

A B 
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The distance between Ser20 and the 4-keto group is 6.890Å in the WT which is not close enough to 

favor a reaction. Only a change in conformation after substrate binding would bring Ser20 into range for 

a reaction to occur. This distance in R382W is 7.652Å, which is too far to predict a change in 

conformation and the orientation of the substrate itself is not favorable. The distances between Asp122 

and the side chain nitrogen of His22 are favorable for both proteins; however, because the other 

distances are not favorable in the mutant protein, the reaction probably does not occur.  

 

Figure 12: Models of A) Cp3GT and B) R382W docked with Luteolin.  

Cyanidin is an interesting substrate because there is not a 4-keto group for Ser20 to interact 

with. Therefore, distances were only measured between His22 and the 7-OH group, as well as Asp122 to 

the side chain nitrogen of His22. The distance between His22 and the 7-OH group in the WT is 5.825Å 

and 5.251Å in the mutant. Both of these distances are outside of the 5Å guideline which suggests that 

the reaction does not occur (Figure 13). It is possible that at certain times His22 is closer to the substrate 

than at other times but this is not likely. However, it has been shown that this reaction does not occur 

B A 
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for WT in a kinetic assay (Owens and McIntosh 2009). This distance for R382W is closer than the WT 

distance, making the reaction slightly more favorable for the mutant but not enough to be considered 

expanded substrate specificity. The distance between Asp122 and the side chain nitrogen of His22 is 

4.591 in WT and 2.737 in the mutant, both of which are favorable distances.  

 

Figure 13: Models of A) Cp3GT and B) R382W docked with Cyanidin. 

 

 

 

  

B B A 
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CHAPTER 4 

CONCLUSIONS AND DIRECTIONS FOR FUTURE RESEARCH 

 Site directed mutagenesis was performed to create the mutation R382W which was an arginine 

changed to a tryptophan at position 382. This mutation was chosen based on homology modeling and 

multiple sequence alignment between Cp3GT and Vv3GT. Cp3GT is highly specific to some flavonols 

while Vv3GT is specific for anthocyanidins but can also glucosylate flavonols. The purpose of this 

research was to determine structure and function of key amino acid residues in Cp3GT. This mutation 

was hypothesized to alter the substrate and/or regiospecificity of Cp3GT to include anthocyanidins.  

 This mutation is within the conserved PSPG box so no variation was observed between the 

amino acids in Cp3GT and Vv3GT during sequence alignment; both enzymes contain an arginine residue 

at the 382nd positon. However, modeling of the quaternary structure of both Cp3GT and R382W showed 

substantial structural differences in the mutant, primarily in the loop regions. Therefore, it was likely 

that this mutation would alter substrate specificity. This is indeed the case in the initial activity 

screening. R382W showed a sharp increase in activity with naringenin and hesperitin which are both 

flavanones. The mutant also retained activity with the flavonols and had a slight increase with 

anthocyanidin. However, this assay is highly sensitive and can produce false positives. As such, these 

results should be confirmed with a kinetic assay (Owens and McIntosh 2009).  

 Docking simulations were performed to visualize the predicted binding pocket conformation 

when bound with the substrates of interest. Distances between three catalytic residues (His22, Asp122, 

and Ser20) and the substrate were used to determine if reactions could be favorable. Any distance 

under 5Å was considered favorable for these docking models (Offen et al 2006). The docking simulations 

showed orientations that favor a reaction for only the flavonols with Cp3GT. However, with R382W 

there were also favorable models for naringenin. This indicates that the activity observed in the initial 
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screening with naringenin could be accurate and not a false positive. This could be should be confirmed 

using HPLC product identification and kinetic analysis. Crystallization of both proteins should be done to 

visualize the correct structure of the binding pocket as these models are only proposed and based off of 

Vv3GT.  

 In the future, the initial screening results should be confirmed. In addition, full biochemical 

characterization should be performed for the mutant protein. Kinetic assays should also be done to 

determine if a change occurred in catalytic efficiency due to the point mutation. HPLC analysis should be 

done to confirm the reaction products of these reactions. These results will be used to refine the in silico 

models to give a more accurate depiction of the binding site and substrate binding. Crystallization 

should also be done for both the WT and mutant proteins to elucidate the exact structure of the 

proteins. However, the results from this study indicate that the point mutation of R382W broadened 

substrate and regiospecificity of Cp3GT to include flavanones.  
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APPENDIX A 

 

Figure A1: Site-directed mutagenesis performed using QuikChange Lightning Site-Directed Mutagenesis 

Kit from Agilent Technologies. 

 

Figure A2: Western Blot of Cp3GT and R382W to confirm size. The proteins with tags are approximately 

65 kDa in size.  
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MAQTQSQPRP HIAVLNFPFS THASSVLSII KRLAVSAPTA LFTFFSTPQS NKALFSTGQQ RHLPSNVKPY 

DVSDGVPEGH VFSGKRQEDI ELFMNAADAN FRKAVEAAVA ETGRPLTCLV TDAFIWFAAE MAREWNNVPW 

VPCWPAGPNS LSAHLYTDII RDKIGTQSQN QDQQLIHFIP GMNKIRVADL PEGVVSGDLD SVFSVMLHQM 

GRQLPKAAAV FINSFEELDP ELTNHLKTKF NNKFLSVGPF KLLLASDQQP SSATDLDDEY GCLAWLDKQK 

KKPASVAYVS FGTVATPSPN EIVAIAEALE ANKVPFIWSL RHRSQANLPN GFLERTRSDG IVVDWAPQVN 

VLAHEAVGVF VTHCGWGSIL ESIAAGVPMI GRPFFGDQRI NGRMMEQVWG VGVAVDGGGI CTKEGLLSSL 

DLILCQEKGI KIREKVTKLK QLCQNAIGPG GSSMQNLDAL VDMISRSY 

 

Figure A3: Cp3GT amino acid sequence. 

 

MAQTQSQPRP HIAVLNFPFS THASSVLSII KRLAVSAPTA LFTFFSTPQS NKALFSTGQQ RHLPSNVKPY 

DVSDGVPEGH VFSGKRQEDI ELFMNAADAN FRKAVEAAVA ETGRPLTCLV TDAFIWFAAE MAREWNNVPW 

VPCWPAGPNS LSAHLYTDII RDKIGTQSQN QDQQLIHFIP GMNKIRVADL PEGVVSGDLD SVFSVMLHQM 

GRQLPKAAAV FINSFEELDP ELTNHLKTKF NNKFLSVGPF KLLLASDQQP SSATDLDDEY GCLAWLDKQK 

KKPASVAYVS FGTVATPSPN EIVAIAEALE ANKVPFIWSL RHRSQANLPN GFLERTRSDG IVVDWAPQVN 

VLAHEAVGVF VTHCGWGSIL ESIAAGVPMI GWPFFGDQRI NGRMMEQVWG VGVAVDGGGI CTKEGLLSSL 

DLILCQEKGI KIREKVTKLK QLCQNAIGPG GSSMQNLDAL VDMISRSY 

 

Figure A4: R382W amino acid sequence.  
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Figure A5: Partial sequencing of Cp3GT and R382W to confirm that the mutation had been inserted 

correctly during site directed mutagenesis. The circled region is the location of the mutation from 

arginine to tryptophan.  

 

Figure A6: Gel electrophoresis to confirm purification of the enzyme. Purification of WT and R382W. 

From right to left: Crude WT(1), crude R382W (2), crude D344P(3), E7 R382W(4), E7 D344P(5), final 

WT(6), final R382W(7), final D344P(8). 
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Figure A7: Western blot time course of protein induction at 0hr (Lane 2), 6hr (Lane 3), 12hr (Lane 4), and 

24hr (Lane 5) of the transformed Pichia pastoris to determine optimal growth time. Lane 1 is a positive 

control and Lane M is the low molecular weight marker.  
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